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Preface

Welcome to Release 11i (11.5.9) of the Oracle Mobile Field Service Implementation 
Guide. Because Oracle Mobile Field Service can be deployed on a laptop computer, 
Palm handheld, and Pocket PC, this guide covers the implementation of Oracle 
Mobile Field Service/Laptop, Oracle Mobile Field Service/Palm, and Oracle 
Mobile Field Service/Pocket PC. Therefore, the term, "Oracle Mobile Field Service 
application" is used in this guide as a reference to either of these applications.

Intended Audience
This guide is intended for implementation engineers, system administrators, and 
any other administrator-level users who are required to implement and/or 
administer an Oracle Mobile Field Service application. 

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/
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1
Introduction

Oracle Mobile Field Service comes in three types—laptop, Palm handheld, and 
Pocket PC. Oracle Mobile Field Service/Laptop, Oracle Mobile Field Service/Palm, 
and Oracle Mobile Field Service/Pocket PC are complete job-management 
applications that help field service representatives (FSRs) complete their daily 
responsibilities. These applications are part of the Oracle Field Service set of 
applications. Oracle Field Service in turn is part of the Oracle E-Business Suite, an 
integrated set of applications that are designed to work together. 

Oracle Mobile Field Service applications synchronize with the enterprise system in 
order to receive new data, such as tasks and service requests, and also to send 
changes made in the application, such as creating report items and updating task 
statuses.

omfs_ig.book  Page 1  Thursday, December 4, 2003  11:31 AM



Overview of Oracle Field Service

1-2 Oracle Mobile Field Service Implementation Guide

The enterprise system is based on the Oracle11i database. Information is exchanged 
between the mobile computer device and the enterprise system via the mobile 
server. The laptop computer uses the Web-to-go server and the Oracle9i Lite 
Database to send and receive information from the mobile server. The Palm 
handheld and Pocket PC use the mSync Client and the Oracle9i Lite Database to 
send and receive information from the mobile server. For additional details, see the 
Oracle Mobile Application Foundation Implementation and Administration Guide, Release 
11.5.9.

1.1 Overview of Oracle Field Service
The Oracle Field Service suite supports an automated process used by service 
organizations to manage their field service operations. It assists in the entire service 
process from taking the customer call to fixing and reporting on the problem at a 
customer site. For a complete description of Oracle Field Service capabilities, see the 
Oracle Field Service Implementation Guide and Appendix J, "Process Flow".

The following table lists all the applications in the suite.

Suite Application Description

Oracle Field Service This application assists in assigning tasks to service 
representatives, creating and dispatching daily 
schedules, monitoring progress, and reporting on 
material, expense, and labor transactions.

Scheduler This application enables optimization of scheduling 
capabilities of tasks to qualified resources. It takes into 
account driving time, distance, and part availability, 
and it creates part reservations.

Spares Management This application is used to provide additional logistics 
and planning features to manage a service parts 
inventory in a multi-location environment.

Oracle Mobile Field 
Service/Laptop

This application is a disconnected application typically 
installed at a field service representative's laptop to 
receive his daily schedule and report on progress, 
material, expense, and labor.

Oracle Mobile Field Service/Palm This application is a disconnected application for a 
Palm handheld so a field service representative can 
receive his daily schedule and report on progress, 
material, expense, and labor.
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The Oracle Mobile Field Service applications integrate with the following 
application modules:

� Oracle Install Base

Tracks the products installed at customer site

� Oracle Application Foundation components 

Oracle Application Foundation components such as Task Manager and 
Resource Manager manage various operations of Oracle Field Service

Oracle Mobile Field 
Service/Pocket PC

This application is a disconnected application for a 
Pocket PC so a field service representative can receive 
his daily schedule and report on progress, material, 
expense, and labor.

Suite Application Description
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1.2 Overview of Oracle Mobile Field Service
Oracle Mobile Field Service converts a portable computer device into a workbench 
for FSRs. Oracle Mobile Field Service is the ideal solution for many service markets, 
such as HVAC, utilities, copier machine maintenance, telecommunications, and 
office-supply industries. This application enable FSRs to print service reports, view 
or update install-base records, and much more. For a complete description on how 
field service representatives may use Oracle Mobile Field Service in their work day, 
see Appendix J, "Process Flow".

For all the Oracle Mobile Field Service applications, the first screen or page 
describes the schedule for the day for the field services representative. This page or 
screen can also describe past and future responsibilities. The following graphics 
depict a typical Oracle Mobile Field Service/Palm Calendar screen and Oracle 
Mobile Field Service/Pocket PC Engineers Task List screen, respectively.
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The following graphic depicts a typical Oracle Mobile Field Service/Laptop 
Calendar page.

1.2.1 Oracle Mobile Field Service Applications Compared
The following table compares the Oracle Mobile Field Service applications by 
feature.

Feature Laptop Palm Pocket PC

View Task Summary Yes Yes Yes

Search Task/SR Yes Yes Yes

Create Task Yes Yes Yes

Auto Assign Tasks Yes Yes Yes

Task Detail/Change Task Status Yes Yes Yes
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Update Task (ETA, Equip ID) Yes Yes Yes

Create Service Request Yes Yes Yes

Service Request Details Yes Yes Yes

Service Request Resolution Yes Yes Yes

View Contractual Details Yes Yes Yes

View Contract Notes Yes Yes Yes

Customer Information Yes Yes Yes

Counter Reading Yes Yes Yes

Labor Debrief Yes Yes Yes

Expense Debrief Yes Yes Yes

Material Debrief Yes Yes Yes

Search Parts Yes Yes Yes

Transfer Parts Yes No No

Create Part Order Yes Yes No

View Part Order Status Yes Yes No

Create/View Notes Yes Yes Yes

Service History Yes Yes Yes

Signature Capture No Yes Yes

Credit Card Validation Yes Yes Yes

Flexfield Support Yes Yes Yes

Customization Support Yes Yes Yes

Printing Yes Yes No

Messaging and Notifications Yes Yes No

View Install Base at Location Yes No Yes

View Install Base Configuration Yes No Yes

Parts Requirement Tied to a Task No No Yes

Feature Laptop Palm Pocket PC
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1.2.2 Oracle Mobile Field Service Key Features Described
The following are key features of Oracle Mobile Field Service:

� Service Requests and Tasks

� Debrief Reporting

� Spares Management

� Mobile Customization Support

1.2.2.1 Service Requests and Tasks
The following are functions:

� View and update service request and task

Upon initial download, a task has a status of "Assigned". However, as the task 
progresses, the field service representative can change this status and task type.

� Work on Task

For a complete description on how field service representatives may complete a 
task, see Appendix J, "Process Flow". 

� Create a service request and task

The dispatch center issues the service request and task to the field service 
representative. On some occasions, a problem may be detected at the customer 
site that was not recognized by the dispatch center. In this case, the field service 
representative can create a service request and task.

Tasks that you create on the mobile computer device are automatically assigned 
to you, provided that the task type is associated with the "dispatch rule" and the 
task has a status of "Assigned." You can immediately work on the new task 
assignment, including entering debriefs.

If the install base item for a service request is not correct, you are able to change 
this install base item. Furthermore, you can create a service request for an install 
base item at the customer location.

� View Service History

The Oracle Mobile Field Service applications display service history for closed 
or completed service requests, detailing any installed base item and customer 
information. 
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Only closed service requests are downloaded with service history. Service 
history information is read-only. If the service request is based on the install 
base product, then the service history for the install base product is available to 
view. Otherwise, for that customer on customer location, history will be 
displayed. 

The following information is replicated for a service history record:

� Closed or completed service request

� Primary contact of this closed service request

� Product or item of the service request excluding parent and child records

� Closed tasks of this service request 

� Closed task assignments of these tasks (role = assignee)

� Resources of these task assignments

� Debrief lines belonging these task assignments

See Appendix K, "Category Set for Item Replication" for additional details about 
information replication.

� View customer and product information

Oracle Mobile Field Service provides you with ample information on the 
customer, such as address and notes. The application likewise describes the 
customer product well.

� Record counter readings

For customer product, Oracle Mobile Field Service enables you set and reset 
counter readings for this product if this is desirable. Counter readings are 
helpful in scheduling maintenance.

� Time zone support

Oracle Mobile Field Service allows operations across multiple time zones. All 
the times displayed on the client are local times. All times are stored in the 
database in server time. Appropriate conversions are made whenever required 
for storage or display. The SERVER_TIMEZONE_ID and CLIENT_TIMEZONE_
ID profiles enable the server and client time zones to be set. If the appropriate 
profile options for either of these profiles are not defined, then no time zone 
conversion will occur and all times will be shown in the server time.
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1.2.2.2 Debrief Reporting
In Oracle Mobile Field Service, a field service representative can report the labor 
time, materials, and expenses incurred during the completion of a task. For any 
labor, material, or expense report item that you create and have not synchronized, 
Oracle Mobile Field Service allows you to delete this report item.

� Material report item

For a material report, field service representatives specify the activity code and 
then the desired report item. Next, they specify how many of the desired items 
they require. To add the desired report item to the material report, the field 
service representative saves this item description.

The following system items are replicated to mobile computer devices:

� Items used in a service request assigned to/created by the mobile user

� Item instance items used in a service request assigned to/created by the 
mobile user

� Items used in debrief lines

� Items used in item orders

� Items present in a good subinventory assigned to the mobile user

� Items present in the inventory organization specified by profile CSL_APPL_
ORGANIZATION_ID. 

� Credit card

Allows capture of credit card information for payment. Giving the customer the 
ability to pay by credit card is a convenience for both the customer and the 
service organization.

� Signature capture

Oracle Mobile Field Service enables you to obtain a customer’s electronic 
signature for task sign off. The customer’s electronic signature indicates that the 
task is complete and that the customer has accepted your work.

Note: For serial-controlled items, the field service representative 
can assign the serial number at debrief time for items not having a 
serial number.
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1.2.2.3 Spares Management
Oracle Mobile Field Service enables you to manage the parts inventory that you can 
use in the repair or replacement of parts for a service request. This is done through 
the following functions:

� Order parts

Field service representatives can order parts if a job requires. A part 
requirement can be tied to a task, and multiple parts can be ordered for each 
requirement.

� View order status

Once a part is ordered, a field service representative can access the status of the 
ordered part.

� Transfer parts

If a part is needed but not available at a convenient inventory, the desired part 
can be transferred to that convenient inventory field service representative. This 
process may prove to be more efficient than ordering the part.

� Category set limiting

A field service organization can have a large number of system items related to 
an inventory organization. However, field service representatives only use a 
portion of these items. To improve synchronization performance and to reduce 
the size of the downloaded data set, you can filter the system by category before 
downloading the data set to the field service representative. 

1.2.2.4 Mobile Customization Support
Mobile customization enables you to tailor Oracle Mobile Field Service functionality 
to fit your business needs and practices. Customization is done through flexfields 
and the Software Development Kit (SDK). See the Customization Support for Oracle 
Mobile Field Service document or OracleMetaLink Note: 248063.1 to learn more about 
the SDK.

� Flexfields

Descriptive flexfields provide customization capabilities in an Oracle Mobile 
Field Service application. This satisfies various user needs without having to 
reprogram the application. 

Users can also use context-sensitive flexfields, when the information stored by 
the application depends on other values users enter in other parts of the form.
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The following table describes the type of flexfields you can find in Oracle 
Mobile Field Service:

� SDK

Through the use of the SDK, you can build custom screens for Oracle Mobile 
Field Service.

1.3 Migration
If you are upgrading from an Oracle Mobile Field Service 11.5.7 or earlier to the 
11.5.9 release, refer to the Oracle Mobile Application Foundation Implementation and 
Administration Guide, Release 11.5.9 to learn how to migrate your existing mobile 
application.

Release 11.5.8 marked the introduction of the Mobile Application Foundation 
architecture, which replaced the CRM Gateway for Mobile Devices architecture 
used in previous releases. Beginning with Release 11.5.8, Oracle Mobile Field 
Service use the new Mobile Application Foundation architecture.

Release 11.5.8 and later releases of Oracle Mobile Field Service are not compatible 
with the pre-11.5.8 CRM Gateway for Mobile Devices architecture. You must 
upgrade the mobile application and foundation at the same time.

Flexfield Laptop Palm Pocket PC

Service request read/write read/write read/write

Task read/write read/write read/write

Task assign read/write NA NA

Debrief header read/write read/write read/write

Debrief line NA NA read/write

Parts requirement NA NA read/write

Item read read read

Product read read read

Customer read read read
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2
Software and Hardware Requirements

This chapter describes the minimum software and hardware requirements of the 
Oracle Mobile Field Service applications.

2.1 Minimum Software Requirements
This section describes the minimum software requirements necessary to run Oracle 
Mobile Field Service on various platforms.

2.1.1 Enterprise Server
Refer to Installing Oracle Applications for the overall software requirements of the 
Oracle E-Business Suite. Also, refer to the Oracle Mobile Application Foundation 
Implementation and Administration Guide, Release 11.5.9.

2.1.2 Laptop Client
� Operating system: Windows NT 4.0 (Service Pack 5), Windows 2000, Windows 

XP, or Windows ME

� Browser: Microsoft Internet Explorer, version 5.5 or later. This is the 
recommended browser for all HTML-based applications.

2.1.3 Palm Client 
This section describes the minimum software requirements for the Palm handheld 
and the PC used during the install.
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2.1.3.1 Desktop PC (Palm Desktop) 
� Operating system: Windows NT 4.0 (Service Pack 5), Windows 2000, Windows 

XP, or Windows ME

� Palm desktop: HotSync Manager and Install Tool.

� Browser: Microsoft Internet Explorer, version 5.5 or later. This is the 
recommended browser.

2.1.3.2 Palm Handheld 
� Operating system: Palm OS 3.5 or higher

2.1.4 Pocket PC Client 
This section describes the minimum software requirements for the Pocket PC and 
the PC used during the install.

2.1.4.1 Desktop PC (Pocket PC Desktop)
� Operating system: Windows NT 4.0 (Service Pack 5), Windows 2000, Windows 

XP, or Windows ME

� ActiveSync 3.6 and above

2.1.4.2 Pocket PC
� Operating system: Pocket PC 2000, Pocket PC 2002, Pocket PC 2003
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2.2 Minimum Hardware Requirements

2.2.1 Enterprise Server
Refer to Installing Oracle Applications for overall hardware requirements for the 
E-Business Suite. Also, refer to the Oracle Mobile Application Foundation 
Implementation and Administration Guide, Release 11.5.9.

2.2.2 Laptop Client
� Computer: IBM-compatible with Pentium III processor

� Disk space: 1 GB

� Monitor: 256 color display

� RAM: 128 MB

� Other requirements: serial port, Internet connection, mouse or pointer device

2.2.3 Palm Client 
This section describes the minimum hardware requirements for the Palm handheld 
and the PC used during the install.

2.2.3.1 Desktop PC 
� Computer: IBM-compatible with Pentium I processor

� Disk space: 50 MB free space

� Monitor: 256 color display

� RAM: 32 MB

� Other requirements: serial port, Internet connection, mouse or pointer device

2.2.3.2 Palm Handheld 
� Device: Any Palm handheld running Palm OS 3.5 or higher 

� RAM: 4 MB of available RAM
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2.2.4 Pocket PC Client 
This section describes the minimum hardware requirements for the Pocket PC and 
the PC used during the install.

2.2.4.1 Desktop PC 
� Computer: IBM-compatible with Pentium I processor

� Disk space: 50 MB free space

� Monitor: 256 color display

� RAM: 32 MB

� Other requirements: serial port, Internet connection, mouse or pointer device

2.2.4.2 Pocket PC
� Pocket PC 2000, Pocket PC 2002, Pocket PC 2003 device

� Processor supported:

� ARM 

� XScale

� 16 MB RAM

2.3 Oracle Mobile Field Service Installation Dependencies
Before setting up the Oracle Mobile Field Service, there are several other Oracle 
applications or components which you must first install and implement. Refer to 
the Mobile Applications: Patch Information document (Note 241425.1 on 
OracleMetaLink) for details on the correct patches, dependencies, and the like.
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3
Implementation

This chapter describes how to implement Oracle Mobile Field Service. The 
following are the basic steps needed to do this:

1. Verify dependencies.

See "Oracle Mobile Field Service Installation Dependencies" on page 2-4.

2. Implement the Mobile Application Foundation.

See "Implementing the Mobile Application Foundation" on page 3-2.

3. Publish the mobile application.

See "Installing the Mobile Application Patches" on page 3-2.

4. Confirm the required enterprise setups.

See "Confirming Required Enterprise Setups" on page 3-3.

5. Set profile options for Oracle Mobile Field Service.

See "Setting Profile Options for Oracle Mobile Field Service" on page 3-7.

6. Schedule concurrent programs.

See "Scheduling Concurrent Programs" on page 3-19.

7. Create and manage mobile users.

See "Creating and Managing Mobile Users" on page 3-20.

8. Test the mobile application implementation. 

See "Testing the Mobile Application Implementation" on page 3-21.
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3.1 Implementing the Mobile Application Foundation
Refer to the Oracle Mobile Application Foundation Implementation and Administration 
Guide, Release 11.5.9 to learn how to implement the Mobile Application Foundation.

3.2 Installing the Mobile Application Patches 
Refer to the Mobile Applications: Patch Information document (Note 241425.1 on 
OracleMetaLink) for details on the correct patches, dependencies, and the like.

Depending on the Oracle Mobile Field Service application you are implementing, 
install the required patches using the AD utility. 

Complete the following steps to install the required patches for the desired Oracle 
Mobile Field Service application:

1. Shutdown Oracle9i Lite mobile server.

2. Install the required patches using the AD utility.

3. Start Oracle9i Lite mobile server.

4. After applying the patch, ensure that the JTM concurrent programs are running.

See "Scheduling Concurrent Programs" on page 3-19 for a complete description 
of this procedure.

omfs_ig.book  Page 2  Thursday, December 4, 2003  11:31 AM



Confirming Required Enterprise Setups

Implementation 3-3

3.3 Confirming Required Enterprise Setups
This section describes how to setup the enterprise-side system so certain mobile 
features work properly on the mobile computer device.

3.3.1 Setting Up Service Requests
The following table lists the service request setups that can be used to create, view, 
and update tasks in an Oracle Mobile Field Service application.

For details, refer to the Oracle Support Implementation Guide.

3.3.1.1 Linking Service Request Statuses to Service Request Types
Service Request Statuses have to be linked to Service Request Types. Use the 
following procedure:

1. Switch to the Field Service Manager responsibility.

2. Navigate to Field Service Setup > Service Requests > Request 
Types.

3. Click to select a Service Request Type from the table.

4. Click Related Statuses. 

5. In the form, link Service Request Statuses to the Service Request Type. 

6. Click Save. 

7. To finish, close the form.

For more information, please refer to the Oracle Support Implementation Guide.

Component Required or Optional

Service Request Statuses Required

Service Request Severities Required

Service Request Types Required

Service Request Urgencies Optional

Problem Codes Optional

Resolution Codes Optional

Service Request Templates Optional
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3.3.2 Setting Up Tasks
The following table lists the task setups that can be used to create, view, and update 
tasks in an Oracle Mobile Field Service application.

Set up the required components listed above. For details, refer to the Oracle Field 
Service Implementation Guide for these Field Service-specific setups.

3.3.3 Setting Up Oracle Field Service Report
Oracle Field Service Report is part of the Oracle Field Service application and is 
used to report all material, expense, and labor transactions. From the Oracle Field 
Service Report screen, you can update inventory, install base, and charges. 

When material, expense, and labor transactions are recorded in one of the Oracle 
Mobile Field Service applications, all transactions are shown and updated to 
inventory, install base, and charges from the Oracle Field Service Report.

Ensure that Oracle Field Service Report is fully implemented and set up as 
described in the Oracle Field Service Implementation Guide. 

See Appendix D, "Setting Up Debrief Reporting" to set up debrief reporting.

Component Required or Optional

Task Statuses Required

Task Status Transitions Required (see 
Appendix F, "Setting Up 
State Transitions") 

Task Types Required

Task Priorities Required

Task Templates Optional 

Notes:

� The task status that is selected during service-task-creation is 
the one from the Field Service profiles: CSF: Default In 
Planning Status. You cannot change this.

� When a service task is created, there will be no task assignment 
automatically created.
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3.3.4 Setting Up Install Base
This procedure is only required if you are using Install Base. If so, Install Base 
should be set up to support Install Base updates when doing material transactions 
in an Oracle Mobile Field Service application. This should be set up after 
performing the setup steps necessary for debrief reporting.

An Oracle Mobile Field Service application supports two scenarios that affect Install 
Base:

� Removing a part

� Installing a new part

The following procedures are required to set up Install Base:

� Setting up system items for Install Base transactions

� Setting up Install Base profile options

� Removing and installing parts in Oracle Mobile Field Service/Laptop

See Appendix E, "Setting Up for Install Base Transactions" for complete details.

3.3.5 Setting Up Counters
The set up of counters is only required if you are using Install Base. The following 
are the setups for counters that must be performed in order to report counter 
readings in an Oracle Mobile Field Service application:

� Counters

� Counter groups

� Counter properties

� Miscellaneous reading types

Refer to the Oracle Service Implementation Guide.

Notes:

� Changing the install base replication profiles during operation 
becomes effective when the value is changed. Information will 
not be changed with retroactive effect based on the profiles.

� Oracle Mobile Field Service/Palm does not support the 
removing of a part from an Install Base.
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3.3.6 Setting Up Messaging
Confirm that Messaging has been successfully installed and implemented. 

Note: Only counters of type REGULAR are supported by the 
Oracle Mobile Field Service applications. Both counter values and 
counter property values can be entered in an Oracle Mobile Field 
Service application.
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3.4 Setting Profile Options for Oracle Mobile Field Service
In the Forms application is where you set profiles. 

The following sections describe Oracle Mobile Field Service features that are 
controlled through profile settings.

3.4.1 Setting up Profile Options for Oracle Mobile Field Service/Laptop
For Oracle Mobile Field Service/Laptop, set the profile options listed in the 
following table. The table indicates the profile option name, a brief description, and 
available options.

Profile Description Options

JTM: Mobile 
Applications Enabled

Set the profile at the 
Oracle Field 
Service/Laptop 
responsibility level to Y. 
Only after setting the 
profile value can 
hooks/business events 
be enabled. 

Y for Yes or N for No.

JTM: Application 
Conflict Rule

Enables Oracle Mobile 
Field Service/Laptop to 
handle updates to the 
database from the 
laptop computer.

Client wins: changes made by the 
mobile user are always applied to the 
enterprise database. No timestamp 
checking is done. 
Timestamp: changes made by the 
mobile user are applied to the 
enterprise database if the record has 
not been modified since the mobile 
user last synchronized. If the record 
has been modified in the meanwhile, 
then the mobile user's change is not 
applied and becomes a deferred 
transaction.
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JTM: Number of 
Previously Closed 
Service Requests

Defines the number of 
previously closed 
service requests to be 
replicated. It is 
recommended that you 
send down three to five 
service requests. Do not 
set very high values 
because of laptop 
computer limitations on 
data set size.

Use 0 to disable the history 
functionality. The default is 0.

JTM: Synchronous 
Service History 
Collection

Sets how previously 
closed service requests 
are collected 
(performance is a 
factor).

Yes for synchronous history 
collection. No for asynchronous 
history collection. The default is No.

JTM: Enable Credit Card 
Functionality

Hides credit card 
information by means 
of a profile.

Yes or No.

CSL: Laptop Inventory 
Organization

All system items from 
the inventory 
organization are 
replicated to the mobile 
client. 

The values are the organization codes 
of the inventory organizations (called 
"organization name" during profile 
setup). 

CSL: Item Category 
Filter

Use to filter item 
categories.

CSL: Item Category Set 
Filter

Use to filter item 
category sets.

CSL: Number of IB Items 
at Location 

The number of install 
base items to be 
downloaded for a given 
customer location.

Can be 0 to any number. The default 
is 0.

Profile Description Options
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CSL: Replicate Install 
Base Product Children

For a service request 
that has an install base 
item, this profile allows 
the children of the 
install base item to be 
viewed in Oracle 
Mobile Field 
Service/Laptop The 
user can view the install 
base item and any 
children of the install 
base item, or one 
hierarchal level below 
the install base item.

Yes or No.

CSL: Replicate Install 
Base Product Parents

For a service request 
that has an install base 
item, this profile allows 
the parents of the install 
base item to be viewed 
in Oracle Mobile Field 
Service/Laptop The 
user can view the install 
base item and the 
parents of the install 
base item, or one 
hierarchal level above 
the install base item.

Yes or No. 

Profile Description Options
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CSF: Business Process Enables you to specify 
the order of task 
completion for the field 
service representative.

Option 1 indicates that the field 
service representative is to work on 
one task at a time in a fixed order 
(ordered by scheduled start date).

Option 2 indicates that the field 
service representative can only work 
on one task, but in any order. Only 
the task with status set to 'Working' 
can be updated. If no task is set to 
'Working', the status of all open task 
can be updated. This way the field 
service representative can select a 
task by setting its status to 'Working'.

Option 3 indicates that the field 
service representative can work on 
any number of tasks in any order. 
The working flag will be ignored in 
this scenario.

CSF: Update 
Planned/Scheduled 
Times Allowed

Specifies whether field 
service representatives 
are allowed to change 
the planned or 
scheduled times of the 
tasks they have 
received on the laptop 
computer.

Yes or No.

CSL: Allow Overlapping 
Labor Lines 

Setting the profile to No 
does not allow 
overlapping labor lines 
within a task.   
Therefore, a field 
service representative 
cannot have two labor 
lines for the same time 
period. The second 
labor line starts only 
after the first one has 
finished. 

Yes or No, with No as the default. 
When the profile option is set to Yes, 
the technician is allowed to enter 
overlapping actual start and end 
times for various assignments for a 
given day. When the profile option is 
set to No, the technician does not 
have the ability to enter the 
overlapping times.

Profile Description Options
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CSL: Time Reasonability 
Check Apply

Reasonability checks to 
ensure that valid inputs 
are entered during 
debrief and task 
creation on the mobile 
computer device.

The following 
reasonability checks 
need to be added to 
Oracle Mobile Field 
Service/Laptop to 
insure quality of data 
entered by the 
technician:

- Values entered for 
Planned Start date/time 
must be greater than 
Incident date/time on 
SR header for 
create/update of task

- Values entered for 
Planned End date/time 
must be greater than 
Incident date/time on 
SR header for 
create/update of task

- Values entered for 
Service Date and Labor 
Start date/time on 
Debrief may not be less 
than Incident date/time 
on SR header.

- Values entered for 
Service Date on Debrief 
may not be less than 
Incident date/time on 
SR header. 

Yes or No, with Yes being the 
default. 

Profile Description Options
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- Values entered for 
Labor Start date/time 
and Service Date on 
Debrief may not be 
future-based on current 
date/time on the 
device.

- Values entered for 
Labor End date/time 
and Service Date on 
Debrief line item may 
not be future-based on 
current date/time on 
the device.

- Values entered for 
Labor End date/time 
and Service Date on 
Debrief may not be less 
than Incident date/time 
on SR header.

CSL: Labor Line Total 
Check

Reasonability check to 
ensure total time at site 
does not exceed total 
labor time plus delta.

For debrief reporting in 
Oracle Mobile Field 
Service/Laptop, the 
difference between max 
(last labor end 
date/time) and min 
(earliest labor start 
date/time) must not be 
more than one hour 
greater than the sum of 
labor line durations.

Max - min <= sum of 
labor lines + T

Where T is the time in 
hours. The profile 
setting will give the 
value for this.

Default is 0.

If set to 0, then the check is not valid.

If set to 1, then T=1

If set to 2, then T=2 

Profile Description Options
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3.4.2 Setting up Profile Options for Oracle Mobile Field Service/Palm
Set the profile options listed in the following table. The table lists the profile option 
name, a brief description, and available options.

CSL: Allow Long Notes Determines if field 
service representatives 
are allowed to enter 
notes longer than 2000 
characters.

Yes to allow long notes; note that the 
maximum character count is 2000. 
With this profile switched on, a field 
service representative can type in 
longer notes which after being saved 
are split into multiple notes. These 
multiple notes are replicated to the 
backend.

CSL: Notifications Scope Defines to whom 
messages can be sent.

Resource group or all users, with 
resource group being the default.

CSL: Number of Days 
Before Data is Removed 
on the Client

Defines the number of 
days for data to remain 
on Oracle Mobile Field 
Service/Laptop after it 
is last edited. When the 
number of days has 
expired, it is removed 
from Oracle Mobile 
Field Service/Laptop.

Number of days before data is 
removed on the client.

Profile Description Options 

JTM: Mobile 
Applications Enabled

Set at the Oracle Field 
Service/Palm 
responsibility level to Y. 
Only after setting the 
profile value can hooks or 
business events be 
enabled. 

Y for Yes or N for No. 

Profile Description Options
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JTM: Application 
Conflict Rule

Enables Oracle Mobile 
Field Service/Palm to 
resolve conflicts between 
multiple updates to the 
same object.

Client wins: Changes made by the 
mobile user are always applied to 
the enterprise database. No 
timestamp checking is done.
Server wins: Changes made by the 
mobile user are applied to the 
enterprise database if the record has 
not been modified since the mobile 
user last synchronized. If the record 
has been updated in the back end, 
then the mobile user's change is not 
applied.

CSM: Number of 
Previously Closed 
Service Requests

Defines the number of 
previously closed service 
requests to be replicated. 
It is recommended that 
you send down three to 
five service requests. Do 
not set very high values 
because of Palm 
handheld limitations on 
data set size.

Use 0 to disable the history 
functionality. The default is 0.

CSM: Synchronous 
History Collection

Sets how previously 
closed service requests 
are collected 
(performance is a factor).

Yes for synchronous history 
collection. No for asynchronous 
history collection. The default is No.

CSF: History_M Defines the number of 
days that data will remain 
in Oracle Mobile Field 
Service/Palm, after it was 
last edited. When the 
number of days expires, 
the data is removed from 
the application.

Number of days before data is 
removed on the client.

If you specify no days, then the data 
is never removed.

JTM: Enable Credit 
Card Functionality

Enables the credit card 
capture functionality.

Yes or No.

CSF: Palm Item 
Organization

All system items from the 
subinventories of the 
inventory organization 
that the user has access to 
are replicated to the 
mobile client. 

The values are the organization 
codes of the inventory organizations 
(called organization name during 
profile setup).

Profile Description Options 
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3.4.3 Setting up Profile Options for Oracle Mobile Field Service/Pocket PC
Set the profile options listed in the following table. The table lists the profile option 
name, a brief description, and available options.

CSM: Item Category 
Filter

Use to filter item 
categories.

CSM: Item Category Set 
Filter

Use to filter item category 
sets.

CSM: Notifications 
Scope

Defines to whom 
messages can be sent.

0 = All Oracle Mobile Field Service 
users.

2 = All the field service 
representatives in the group

CSF: Conform to 
Schedule

Specifies whether field 
service representatives 
must conform to the 
schedule or they are 
allowed to complete tasks 
in any sequence on their 
laptop computer or Palm 
handheld. 

Yes or No.

Service: Inventory 
Validation Organization

Used to validate 
inventory item IDs that 
are associated with 
debrief lines.

Define the master organization for 
the user at the responsibility level 
for Oracle Mobile Field 
Service/Palm. Therefore, all 
downloaded inventory items will be 
validated.

Profile Description Options 
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Profile Description Options 

JTM: Mobile 
Applications Enabled

Set at the Oracle Field 
Service/Palm 
responsibility level to Y. 
Only after setting the 
profile value, can hooks 
or business events be 
enabled. 

Note: The Oracle Field 
Service/Palm 
responsibility is used for 
both the Oracle Mobile 
Field Service/Palm and 
Oracle Mobile Field 
Service/Pocket PC 
applications.

Y for Yes or N for No.

JTM: Application 
Conflict Rule

Enables Oracle Mobile 
Field Service/Pocket PC 
to resolve conflicts 
between multiple updates 
to the same object.

Client wins: Changes made by the 
mobile user are always applied to 
the enterprise database. No 
timestamp checking is done. 
Server wins: Changes made by the 
mobile user are applied to the 
enterprise database if the record has 
not been modified since the mobile 
user last synchronized. If the record 
has been updated in the back end, 
then the mobile user's change is not 
applied.

CSM: Number of 
Previously Closed 
Service Requests

Defines the number of 
previously closed service 
requests to be replicated. 
It is recommended that 
you send down three to 
five service requests. Do 
not set very high values 
because of Pocket PC 
limitations on data set 
size.

Use 0 to disable the history 
functionality. The default is 0.

CSM: Synchronous 
Service History 
Collection

Sets how previously 
closed service requests 
are collected 
(performance is a factor).

Yes for synchronous history 
collection. No for asynchronous 
history collection. The default is No.
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CSF: History_M Defines the number of 
days that data will remain 
in Oracle Mobile Field 
Service/Pocket PC, after 
it was last edited. When 
the number of days 
expires, the data is 
removed from the 
application. 

A value representing the number of 
days before data is removed from 
Oracle Mobile Field Service/Pocket 
PC.

If you specify no days, then the data 
is never removed.

JTM: Enable Credit 
Card Functionality

Enables the credit card 
capture functionality.

Yes or No.

CSF: Palm Item 
Organization 

All system items from the 
subinventories of the 
inventory organization 
that the user has access to 
are replicated to the 
mobile client. 

The values are the organization 
codes of the inventory organizations. 

CSF: Business Process Enables you to specify the 
order of task completion 
for the field service 
representative.

Option 1 indicates that the field 
service representative is to work on 
one task at a time in a fixed order 
(ordered by scheduled start date).

Option 2 indicates that the field 
service representative can only work 
on one task, but in any order. Only 
the task with status set to 'Working' 
can be updated. If no task is set to 
'Working', the status of all open task 
can be updated. This way the field 
service representative can select a 
task by setting its status to 
'Working'.

Option 3 indicates that the field 
service representative can work on 
any number of tasks in any order. 
The working flag will be ignored in 
this scenario.

CSM: Item Category 
Filter

Use to filter item 
categories.

CSM: Item Category Set 
Filter

Use to filter item category 
sets.

Profile Description Options 

omfs_ig.book  Page 17  Thursday, December 4, 2003  11:31 AM



Setting Profile Options for Oracle Mobile Field Service

3-18 Oracle Mobile Field Service Implementation Guide

CSM: Number of IB 
Items at Location 

The number of install 
base items to be 
downloaded for a given 
customer location.

Can be 0 to any number. The default 
is 0.

CSM: Restrict Number 
of Items to Search for in 
LOV

Limits the number of 
search results shown in 
the search screens if there 
are too many items. The 
user can limit the search 
by using a filter to reduce 
the number of items 
retrieved in the search. 

Can be 1 to any number. The default 
is 100. 

Service: Inventory 
Validation Organization

Used to validate 
inventory item IDs that 
are associated with 
debrief lines.

Define at responsibility level for 
Oracle Mobile Field Service/Pocket 
PC to be the master organization for 
the user. Hence, all downloaded 
inventory items will be validated.

Profile Description Options 
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3.5 Scheduling Concurrent Programs
Concurrent program scheduling is categorized for the lookup, transaction, and 
inventory categories. 

Formerly, all concurrent programs were registered with one JTM concurrent 
program, MOBILE_CON_PROGRAM. JTM has a new concurrent program, JTM Master 
Concurrent Program, which accepts the lookup, transaction, and inventory 
categories as parameters. Now, concurrent programs are categorized for the lookup, 
transaction, and inventory categories. 

For an Oracle Mobile Field Service application, schedule the concurrent programs 
listed in the table below. For instructions on how to set up concurrent programs, 
refer to the Oracle Applications System Administrator’s Guide.

Name Application Description
Default (Recommended) 
Schedule 

Processes Uploaded Mobile 
Data

Laptop

Palm

Pocket PC

Processes uploaded mobile 
data and applies it to the 
enterprise system 

Every 1 minute

Manage Mobile Users Laptop

Palm

Pocket PC

Creates or removes mobile 
users automatically based 
on assigned mobile 
responsibilities 

Every 1 hour

JTM: Master Concurrent 
Program

Laptop

Palm

Pocket PC

The JTM master concurrent 
program, which runs all 
concurrent jobs registered 
by mobile applications 

TRANSACTION: every 5 minutes

LOOKUP: every 30 minutes

INVENTORY: once a day

PURGE: as often as required
(Default is set to once per month)

Workflow Background 
Process

Palm

Pocket PC

Item Type: CSM Type3

Process Deferred: Yes

Process Timeout: Yes

Process Stuck: Yes

Start: Right at the moment

Run the job: Periodically

Re-run: Every 0.5 minute

Apply the Interval: From the 
completion of the prior run
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3.6 Creating and Managing Mobile Users
Users who have the Oracle Field Service/Palm responsibility assigned to them have 
access to either the Oracle Mobile Field Service/Palm or Oracle Mobile Field 
Service/Pocket PC application. Likewise, users who have the Oracle Field 
Service/Laptop responsibility assigned to them have access to the Oracle Mobile 
Field Service/Laptop application. To create users for an Oracle Mobile Field Service 
application, create the users as described in the Oracle Field Service Implementation 
Guide. Ensure that the following procedures have been completed: 

� Setting Up Employees

� Setting Up Resources

� Setting Up Field Service

After completing these procedures, assign either the Oracle Field Service/Palm or 
Oracle Field Service/Laptop responsibility to the users, depending on the Oracle 
Mobile Field application they are using. Access to the Oracle Mobile Field Service 
application is based on the same usernames and passwords as the enterprise 
system.

There is a concurrent program in the Mobile Application Foundation that 
periodically allocates resources for users that have a mobile responsibility, so there 
will be a delay between when the responsibility is assigned and when the change 
will take effect. Refer to the Oracle Mobile Application Foundation Implementation and 
Administration Guide, Release 11.5.9 for information on how to manually run the 
concurrent program to expedite the creation of a new user.

Mobile users can change their passwords in the Forms application or by requesting 
that the system administrator make this change for them. Both of these topics are 
described in the Oracle Applications System Administrator’s Guide.

Note: If there is a major delay for the Workflow Background 
Process to handle the item type CSM TYPE3 processes, then you 
should schedule more than one Workflow Background Process 
concurrent programs for item type CSM TYPE3. The number of 
Workflow Background Process concurrent programs to be 
scheduled depends on the workload of how many CSM TYPE3 
processes are to be processed. This is important to boost the 
performance and ensure that mobile users can get online updates 
promptly.
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If you remove the Oracle Field Service/Laptop responsibility or Oracle Field 
Service/Palm responsibility from a user, that user will no longer be able to use the 
Oracle Mobile Field Service application and synchronize. However, the application 
will remain on his mobile computer device.

For further details about creating and managing mobile users, refer to note 219019.1 
on OracleMetaLink.

3.7 Testing the Mobile Application Implementation
Once you have implemented Oracle Mobile Field Service, you should then test that 
the implementation is successful.

3.7.1 Running the Test

Steps
Complete the following steps to verify that the implementation of the Oracle Mobile 
Field Service application was successful:

1. Create a test user and then assign the user either the Oracle Field 
Service/Laptop or Oracle Field Service/Palm responsibility, depending on the 
type of Oracle Mobile Field Service application.

2. Install the Oracle Mobile Field Service application on the desired test mobile 
computer device.

� For details on how to install Oracle Mobile Field Service/Laptop, refer to 
Appendix A, "Installing Oracle Mobile Field Service/Laptop".

� For details on how to install Oracle Mobile Field Service/Palm, refer to 
Appendix B, "Installing Oracle Mobile Field Service/Palm".

� For details on how to install Oracle Mobile Field Service/Pocket PC, refer to 
Appendix C, "Installing Oracle Mobile Field Service/Pocket PC".

3. From the Field Service Dispatch Center, create a task and then assign it to the 
test user.

Note: The Oracle Field Service/Palm responsibility is used for 
both the Oracle Mobile Field Service/Palm and Oracle Mobile Field 
Service/Pocket PC applications.
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4. Synchronize the mobile computer device.

The Oracle Mobile Field Service application receives the task.

5. Change the task assignment status on the mobile computer device and then 
synchronize. 

6. Confirm that the task status update is reflected in the dispatch center. 

3.7.2 Final Checks
If you have problems running the Oracle Mobile Field Service application, ensure 
that you have met the following requirements:

� Material items must be created and associated with the field service 
representative’s inventory.

� The task state transitions must be set up in Field Service.

� Field service representatives must have a location associated with them.

� A request or task must have a location before it can be scheduled.

� The Oracle Field Service/Laptop responsibility or Oracle Field Service/Palm 
responsibility must be granted to you, depending on the Oracle Mobile Field 
Service application that you are using.

� Labor and expense items need to be set up.

� If you are still experiencing problems, then use the diagnostics described in 
"Running Diagnostic Tests" on page 4-2.

Note: The Oracle Field Service/Palm responsibility is used for 
both the Oracle Mobile Field Service/Palm and Oracle Mobile Field 
Service/Pocket PC applications.
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4
Administrating and Troubleshooting

This chapter describes how to perform Oracle Mobile Field Service administrative 
tasks and how to troubleshoot runtime problems. 

4.1 Setting the Conflict Resolution Rule
The profile option, JTM: Application Conflict Rule, specifies the conflict resolution 
rule that is used in case of updates to the same entity by both the enterprise system 
and the Oracle Mobile Field Service application. 

This profile option determines how the Oracle Mobile Field Service application 
makes updates to the database. The following are the possible types of updates:

� Client wins. Changes made by the mobile user are always applied to the 
enterprise database. No timestamp checking is done.

� Server wins. Changes made by the mobile user are applied to the enterprise 
database if the record has not been modified since the mobile user last 
synchronized. If the record has been modified in the meanwhile, then the 
mobile user’s change is not applied.

4.2 Reviewing Upload Errors
Upload errors are generated during the upload process when some of the data fails 
to be applied to the enterprise database. Upload errors can be caused by the 
following:

� System issues

It is possible that the system is on a different mobile patch level than what is 
required.
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� Setup issues

The right business process type or the right profile setting is not set on the 
enterprise system. For example, it is necessary that the expense type for an 
expense line is set correctly.

� Faulty data or conflicts

The Mobile Application Foundation maintains a log of all upload errors. You can 
use the Mobile Application Foundation Administration Console to view and 
manage these errors. Refer to the Oracle Mobile Application Foundation Implementation 
and Administration Guide, Release 11.5.9 to learn how to resolve upload error issues.

4.3 Running Diagnostic Tests
Diagnostic testing can be done for the Mobile Application Foundation and the 
Oracle Mobile Field Service application. 

4.3.1 Testing Mobile Application Foundation
For instructions on how to run a diagnostic test against the Mobile Application 
Foundation, refer to the Oracle Mobile Application Foundation Implementation and 
Administration Guide, Release 11.5.9.

4.3.2 Testing Mobile Applications
Run the following diagnostic test to ensure that the install and operation of the 
Oracle Mobile Field Service application is correct. 

Steps
Complete the following steps to access the diagnostic screens of the Forms 
application:

1. Log in to the CRM System Administrator Console as a system administrator.

2. Click the Diagnostics tab.

3. Depending on your mobile computer device, choose either Oracle Field 
Service/Palm or Oracle Field Service/Laptop from the Application drop-down 
list.
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The Diagnostics application displays the Test Summary table and a table 
showing any failures in the past week.

4. Click the Advanced tab.

In the Advanced tab, enter the parameters for the test that you want to run. 
From the Basic tab, you can run all non-parameter tests for the application.

Refer to the Oracle Applications CRM System Administrator’s Guide or the online 
help system to learn how to use the Diagnostics Framework user interface.

The client-side tests run automatically on the mobile computer device when you 
open an Oracle Mobile Field Service application. You can also run these tests any 
time to verify the correct setup of the Oracle Mobile Field Service application. 

The following table lists diagnostic tests, test descriptions, observed symptoms, and 
proposed resolutions for Oracle Mobile Field Service/Laptop:

Note: The Oracle Field Service/Palm responsibility is used for 
both the Oracle Mobile Field Service/Palm and Oracle Mobile Field 
Service/Pocket PC applications.

Test for Oracle Mobile Field 
Service/Laptop Location Problem Resolution 

JTM Master Concurrent Program Backend Are the concurrent programs 
running?

Provides detailed 
diagnostic information 
about the JTM Master 
Concurrent Program. If 
necessary, it tells system 
administrators which 
settings should be 
modified.
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The following table lists diagnostic tests, test descriptions, observed symptoms, and 
proposed resolutions for Oracle Mobile Field Service/Palm:

Environment Setup Backend Is the environment correct? Provides support for 
debugging the 
configuration of Oracle9i 
Lite. It allows the 
administrator to check if 
the recommended 
settings are followed 
correctly. It also helps in 
identifying common 
issues with external 
authentication, 
installation manager, 
profile option values, 
etc.

Test for Oracle Mobile Field 
Service/Palm Location Problem Resolution 

Check Oracle9i Lite Version and 
libraries

Client Side Incompatible Oracle9i Lite 
version or missing libraries.

Install correct Oracle9i 
Lite libraries.

Check Database - Publication Items 
and other Oracle9i Lite tables

Client Side Required objects missing. The 
application opens with no 
tables or data.

Re-install client 
application.

User authentication Client Invalid username or 
password.

Check username, 
password, and user 
subscriptions.

Check Palm OS version Client Application is not certified 
with Palm OS 3.5 or lower.

Install Palm OS 3.5 or 
higher.

Responsibility Backend User may not have proper 
responsibility.

Assign proper 
responsibilities.

Profile values Backend Profile values for Field Service 
Palm are not set.

Set profile values.

User Hooks Registration Backend Hooks registration is not done. Contact your Oracle 
technical support 
representative.

Test for Oracle Mobile Field 
Service/Laptop Location Problem Resolution 
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The following table lists diagnostic tests, test descriptions, observed symptoms, and 
proposed resolutions for Oracle Mobile Field Service/Pocket PC:

Check Concurrent Program Backend All required concurrent 
programs might not be 
running.

Make sure that the 
concurrent programs are 
running.

JTM Concurrent Program 
registration

Backend For JTM Concurrent Program 
APIs are not registered.

Contact your Oracle 
technical support 
representative.

JTM Master Concurrent Program Backend Are the concurrent programs 
running?

Provides detailed 
diagnostic information 
about the JTM Master 
Concurrent Program. If 
necessary, it tells system 
administrators which 
settings should be 
modified.

Environment Setup Backend Is the environment correct? Provides support for 
debugging the 
configuration of Oracle9i 
Lite. It allows the 
administrator to check if 
the recommended 
settings are followed 
correctly. It also helps in 
identifying common 
issues with external 
authentication, 
installation manager, 
profile option values, 
etc.

Task diagnostic Backend Task is assigned incorrectly. Assign task correctly.

Check required list of values Backend List of values are empty. Create all list of values.

Test for Oracle Mobile Field 
Service/Pocket PC Location Problem Resolution 

Responsibility Backend User may not have proper 
responsibility.

Assign proper 
responsibilities.

Test for Oracle Mobile Field 
Service/Palm Location Problem Resolution 
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Profile values Backend Profile values for Field Service 
Palm are not set.

Set profile values.

User Hooks Registration Backend Hooks registration is not done. Contact your Oracle 
technical support 
representative.

Check Concurrent Program Backend All required concurrent 
programs might not be 
running.

Make sure that the 
concurrent programs are 
running.

JTM Concurrent Program 
registration

Backend For JTM Concurrent Program 
APIs are not registered.

Contact your Oracle 
technical support 
representative.

JTM Master Concurrent Program Backend Are the concurrent programs 
running?

Provides detailed 
diagnostic information 
about the JTM Master 
Concurrent Program. If 
necessary, it tells system 
administrators which 
settings should be 
modified.

Environment Setup Backend Is the environment correct? Provides support for 
debugging the 
configuration of Oracle9i 
Lite. It allows the 
administrator to check if 
the recommended 
settings are followed 
correctly. It also helps in 
identifying common 
issues with external 
authentication, 
installation manager, 
profile option values, 
etc.

Task diagnostic Backend Task is assigned incorrectly. Assign task correctly.

Check required list of values Backend List of values are empty. Create all list of values.

Test for Oracle Mobile Field 
Service/Pocket PC Location Problem Resolution 
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4.4 Configuring Logging
Oracle Mobile Field Service applications use the CRM Technical Foundation logging 
framework to log messages to a central repository that is shared by both the 
database and the middle tier servers. Each log message belongs to one of the 
following six severities: 1-Statement, 2-Procedure, 3-Event, 4-Exception, 5-Error, 
6-Unexpected. UI screens give system administrators convenient and simple 
controls for configuring and viewing the logs. 

Refer to the Oracle Applications CRM System Administrator’s Guide or the online help 
to learn how to use the Logging screens.

Steps
Complete the following steps to configure logging for all modules:

1. Log in to the CRM System Administrator Console as a system administrator.

2. Navigate to Setting > System > Debug Logging > Configuration.

3. Set the following values:

� Enabled = ON

� Level = Statement 

� Repository = Database

� Module filter = include string csm%

4. Click Update to save the values.

5. Bounce Apache (the middle-tier server).

In addition to these logs, you can use the Oracle9i Lite Mobile Server logging 
facility to troubleshoot problems with user synchronizations. Refer to the Oracle9i 
Lite Mobile Server Administration Guide Release 5.0.2 for more details. 

Note: Turn the logger off after you finish troubleshooting. This 
changes the values of the above fields back to their original values. 
Logging at this level of detail consumes resources and could impact 
the performance of your system.
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4.5 Common Issues
This section describes the most common issues encountered in the implementation 
of Oracle Mobile Field Service.

4.5.1 Viewing Items Stocked in a Subinventory

Problem
Trackable items that have been stocked in a subinventory are now displayed in the 
inventory list of the application.

Resolution
This may be a replication issue. Please check that the installed base instances have 
been created for the stocked items in the back of the database. If the instances do 
exist but the items still do not display on the laptop, please contact Oracle Support. 
For more information about trackable items, see Appendix D, "Setting Up Debrief 
Reporting".
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A
Installing Oracle Mobile Field

Service/Laptop

This appendix describes how to install Oracle Mobile Field Service/Laptop onto a 
laptop computer and how to launch the application.

A.1 Installing the Application on Your Laptop Computer
This section describes how to install the Web-to-Go server and Oracle9i Lite 
database, in addition to the Oracle Mobile Field Service application. This additional 
software is necessary for Oracle Mobile Field Service to operate.

For the minimum software and hardware requirements for the a laptop computer, 
see "Minimum Software Requirements"  on page 2-1 and "Minimum Hardware 
Requirements"  on page 2-3.

Steps
Complete the following steps to install Oracle Mobile Field Service/Laptop on your 
laptop computer:

1. Open a Web browser window.

2. Open the following URL, where <Mobile Server> is the domain name or IP 
address of the Mobile Server:

http://<Mobile Server>/setup

For example: http://130.35.88.214/setup

3. Click the link to download the Mobile Client for Laptop setup program and 
save it.
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If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as and then click OK. Choose a location to save the setup program 
and then click Save.

4. From Windows Explorer, double-click the setup.exe file that you just 
downloaded.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory.

For example, C:\ora_HOME and then click OK. The setup program downloads 
all the required components.

Once the installation is complete, your browser launches and opens the Oracle9i 
Lite Workspace Logon page. This page contains fields where you specify your 
user name and password.

 

If the browser does not launch automatically, the setup program will display 
the Web-to-Go URL. For example, http://my-laptop. In this case, click the 
URL. 
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6. After the browser launches, logon using the same user name and password that 
you use for online applications.

If the browser returns a "Page Not Found" error, check your proxy settings. In 
Microsoft Internet Explorer, ensure that the Bypass Proxy for Local Addresses 
check box is selected under Tools > Internet Options > Connections 
> LAN Settings. Reload the page and try again. 

7. Click Logon.

The Oracle9i Lite Client Initialization page opens with initialization status for 
the files and records of Oracle Mobile Field Service/Laptop. This status 
includes the amount of bytes downloaded onto your laptop computer.

8. Click Next.

Note: You can always use the URL http://localhost to access 
the Web-to-Go server without having to know the name of the 
laptop computer.
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The Oracle9i Lite Client Synchronization page opens with the current 
synchronization process in bold, italic text. A percentage value is found near 
each synchronization process to indicate its status. The initial synchronization 
downloads the application and your initial set of data. The synchronization 
takes several minutes; therefore, do not exit the browser until the 
synchronization is complete.

After synchronization completes, the browser displays the Oracle9i Lite 
Workspace page. 
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9. Click Field Service Laptop.

The Oracle Mobile Field Service/Laptop Calendar page opens.
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A.2 Starting Oracle Mobile Field Service/Laptop

Steps
Complete the following steps to start Oracle Mobile Field Service/Laptop:

1. From the Start menu, choose Programs > Oracle for Windows NT > 
Web to Go.

The internet browser opens in the login page. You can also access the login page 
by clicking on the Web-to-Go icon on the desktop.

Your internet browser opens the Oracle E-Business Suite login page.

2. Enter your user name and password in the appropriate fields and then click Go.

Oracle Mobile Field Service/Laptop opens in the Calendar page (Daily View).

In order to receive new data assigned to you, such as new tasks and service 
requests, you need to synchronize with the enterprise system. Likewise, to send 
the changes that you make, such as creating debrief lines and updating task 
statuses, you need to synchronize with the enterprise system.

3. To do an incremental synchronization, click the Synchronize button in the 
upper right corner of the Calendar page.

The Oracle E-Business Suite Client Synchronization page opens with the current 
synchronization process in bold, italic text. A percentage value is found near 
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each synchronization process to indicate its status. Click Cancel to terminate the 
current synchronization process.
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B
Installing Oracle Mobile Field Service/Palm

This appendix describes how to install Oracle Mobile Field Service onto a Palm 
handheld.

B.1 Installing the Application on Your Palm Handheld
For the minimum software and hardware requirements for the a Palm handheld, 
see "Minimum Software Requirements"  on page 2-1 and "Minimum Hardware 
Requirements"  on page 2-3.

To install Oracle Mobile Field Service on your Palm handheld, complete the 
procedures listed in the following table:

Procedure Performed At

Procedure 1: Downloading and Installing the Oracle9i Lite 
Setup Program 

Client PC (the PC that the 
Palm handheld HotSyncs 
to)

Procedure 2: Performing a HotSync to put Oracle9i Lite 
Components on the Palm handheld

Client Palm

Procedure 3: Establishing an Oracle Conduit on the Palm 
HotSync Manager

Client PC

Procedure 4: Configuring mSync on the Palm handheld Client Palm

Procedure 5: Performing a Full Synchronization to Retrieve 
the Field Service Application and Data

Client Palm

Procedure 6: Launching the Oracle Mobile Field Service 
application

Client Palm
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See Appendix E, "Setting Up for Install Base Transactions" for details on how to set 
up the various modes of communication with the Palm handheld.

B.1.1 Step 1: Downloading and Installing the Oracle9i Lite Setup Program
Perform this procedure from the client PC desktop. In this procedure, you will 
download the mobile client from the Mobile Server and install the Oracle9i Lite 
setup program. 

Steps
1. Open your browser.

2. Enter the following URL in your browser, where <Mobile Server> is the 
domain name or IP address of the Mobile Server:

http://<Mobile Server>/setup

For example: http://130.35.88.214:8000/setup

3. Click the link to download the Mobile Client for Palm setup program and save 
it.

If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as, and then click OK. Choose a location to save the setup program 
and click Save.

4. Using Windows Explorer, double click the setup.exe file that you just 
downloaded in order to run the setup program.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory, for example, C:\ora_HOME, and then click OK. 

The Setup program downloads all the required components.

6. After you download the necessary files, the setup program prompts you to 
select a Palm user. 

When you have installed the Palm handheld desktop, the setup program 
informs you that the components are successfully installed and will be 
uploaded with the next HotSync.

Note: If the Palm handheld desktop is not installed, the setup 
program will prompt you to install it. Also, you will need to 
manually publish all PRC files if they have not been published.
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If you have not installed the Palm handheld desktop, install the Palm handheld 
desktop and rerun the setup program. 

B.1.2 Step 2: Performing a HotSync to put Oracle9i Lite Components, Oracle Mobile 
Field Service, and the Database on the Palm Handheld

Complete the following procedure:

Steps
1. After you download and install the Palm handheld desktop, launch the Palm 

handheld desktop. 

2. From the HotSync menu, select Setup, click the Network tab, then select the 
user for performing a network HotSync operation.

3. Perform a HotSync to put Oracle9i Lite components, the application, and the 
database on the Palm handheld.

To do a HotSync to retrieve the actual Oracle Mobile Field Service application and 
the data associated with it, the computer that hosts the HotSync Manager must 
have an HTTP connection with the Mobile Server. 

B.1.3 Step 3: Establishing an Oracle Conduit on the Palm HotSync Manager
Complete the following procedure:

Steps
1. Copy the conshttp_reg.exe file from C:/ORANT/palm to the HotSync 

directory.

2. Start the HotSync Manager.

3. Run conshttp_reg.exe. When you double-click the file, nothing will be 
displayed, but the program will indeed be running.

4. Close and restart the HotSync Manager. 

B.1.4 Step 4: Configuring mSync on the Palm Handheld
Follow this procedure to install the Oracle Mobile Field Service application and the 
database on the Palm handheld. 
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Steps
1. Tap the mSync icon on the Palm handheld.

The mSync screen opens.

2. In the mSync screen, specify information as indicated in the following table and 
then tap Sync:

Information Description

User Name mSync client user name. This is case insensitive. (This is 
the Mobile Field Service username.)

Password mSync client password. This is case insensitive.

Change Leave this check box deselected.

Save Password Select this check box to save the mSync username and 
password.

Server IPaddress:port

Proxy Select this check box if appropriate.

Palm.net Select this check box if you want to synchronize your Palm 
handheld using a network.

Forced N/A
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B.1.5 Step 5: Performing a Full Synchronization to Retrieve Oracle Mobile Field 
Service and Data

Steps
Complete one of the following steps to perform a full synchronization:

� If you are using HotSync, do a HotSync.

� If you are using RAS/modem, tap Sync on the mSync screen. 

B.1.6 Step 6: Launching Oracle Mobile Field Service/Palm
Complete the following procedure to launch the Oracle Mobile Field Service 
application on the Palm handheld. 

Steps
1. Tap the Applications icon on the Palm handheld to display the application 

picker.

2. Tap the Field Service icon from the application launcher.

Note: Repeat this step to do an incremental synchronization.
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B.2 Configuring the Palm Handheld for RAS or a Modem
In addition to using the HotSync option to synchronize Oracle Mobile Field 
Service/Palm and the database, Remote Access Server (RAS) or a modem can also 
be used to synchronize.

B.2.1 Connecting to a RAS Client
To configure HTTP as the transport mechanism for Palm OS 3.5, use the following 
procedure: 

Steps
1. From the Palm handheld desktop, tap the Prefs icon.

The Preferences screen opens, displaying the date and time.

2. From the drop-down list, select Connection.

The Preferences screen displays a list of available connections.
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3. Tap New. 

The Edit Connection screen opens.

4. Enter the following:

� Name: HTTP

� Connection Method: Serial to PC

5. Tap OK to close the Edit screen.

6. Tap OK to close the Preferences screen.

7. Select Network from the menu.

The Preferences screen opens.

8. For each field, enter the value as indicated in the following table:

9. Tap the Details button. 

Field Value

Service Windows RAS

User Name User name

Password User password

Connection HTTP

End No information required
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The Details dialog box opens.

10. Make sure that IP Address: Automatic is selected.

11. Tap the Script button. 

The Log in Script dialog box opens.

12. For each field, enter the value as indicated in the following table:

13. Tap the OK button to close the Log in Script dialog.

14. Tap the OK button again to close the Details dialog.

15. Place the Palm handheld in the HotSync cradle.

16. Tap the Connect button to test the connection. 

If the PPP connection is successful, the Palm handheld is ready for data 
synchronization.

B.2.2 Connecting to a Wired Modem
Use this procedure if you are connecting to a wired modem.

Steps
1. Tap the Applications picker.

2. Tap Prefs.

3. In the Preferences screen of the Palm handheld, select Modem from the menu. 

The Preferences screen opens.

4. Verify that the speed is set to 19200 bps.

5. Select Network from the menu. 

Field Value

Send CR no information required

Delay 1

Send CLIENT

Wait For CLIENTSERVER

End no information required
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The Preferences screen opens.

6. For each field, enter the value as indicated in the following table:

7. Tap the Details button. 

The Details dialog box opens.

8. Ensure that the Connection Type is set to PPP.

9. Ensure that the Query DNS is selected.

10. If the Palm does not locate the correct database, enter the Primary DNS and 
Secondary DNS of the RAS system.

11. Ensure that for IP Address: Automatic is selected.

12. Tap the Script button. 

The Log in Script dialog box opens.

13. For each field, enter the value as indicated in the following table:

14. Tap OK to close the Log in Script dialog box.

15. Tap OK again to close the Details dialog box.

16. Place the Palm handheld in the HotSync cradle.

Field Value

Service Windows NT RAS

User Name The user's name

Password The user's password

Phone Telephone number of modem to dial

Field Value 

Send CR No information required

Delay 1

Send CLIENT

Wait for CLIENTSERVER

End No information required
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17. Tap the Connect button to test the connection. 

If the PPP connection is successful, the Palm handheld is ready for data 
synchronization.
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B.3 Using Windows NT RAS
This section describes how to configure Windows NT RAS and then establish a RAS 
user account.

B.3.1 Configuring Windows NT RAS
Replicating with the Palm Computing Platform using Scout or HTTP requires the 
TCP/IP communication protocol. Oracle Mobile Field Service uses serial lines for 
connection to the network. This section provides instructions for enabling TCP/IP 
communications for Palm handhelds using Windows NT RAS.

Perform this procedure to enable TCP/IP communications between handheld 
devices and your Windows NT server using Windows NT RAS.

The following figures show the architecture that can be used by the Field Service 
representative to synchronize data between the Palm handheld and the Mobile 
Server, either at home or in the office.

The following illustration shows the most direct connection of a Palm handheld 
with the Mobile Server, where a serial connection connects the Palm handheld with 
the Mobile Server, and a LAN connection connects the Mobile Server with the 
enterprise server.

This connection requires the following setup steps: 

� Setting up a RAS server.
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� Creating a RAS user account for the Palm handheld.

� Configuring the Palm handheld (connected to a PC client). 

The following illustration shows another possible connection scenario, where a 
serial connection connects the Palm handheld with a PC client, a modem connection 
connects the PC client with a Remote Access Server, and a LAN connection connects 
the Remote Access Server with the enterprise database.

This connection requires the following setup steps:

� Setting up a RAS server.

� Creating a RAS user account for the Palm handheld. 

� Setting up the Palm handheld (connected to a RAS client).

Another way to connect the Palm handheld is shown in the next illustration, where 
the Palm handheld has its own modem that connects to the modem of the RAS. This 
is a valid setup when the field service representative is on duty in the field. 
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This connection requires the following setup step:

� Setting up the Palm handheld (connected to a wired modem)

Prerequisites
� Request a TCP/IP address range equal to the number of clients plus 1. 

Typically, one Palm handheld is connected to the COM port; therefore, the End 
address will be one number higher than the Start address.

� You must make sure that the TCP/IP addresses are not already in use by other 
computers in your network.

Steps
1. In the Windows Control panel, double-click the Network icon.

2. Click Add in the Services tab of the Network window.

3. Select Remote Access Service and then click OK.

4. Insert the Windows NT CD-ROM into the CD-ROM drive and specify the 
location where you want the setup program to search for existing Windows NT 
RAS files. 
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5. Click the Continue button. 

The setup program copies the Windows NT RAS files into the appropriate 
directories. If the setup program fails to detect a modem, it prompts you to add 
a modem. 

6. Click the Yes button and enter the required information to install a modem. 

The Add RAS handheld window opens.

7. Select COM1-Dial-Up Networking Serial Cable from the drop-down list. 

If no COM1-Dial-Up Networking Cable option is available from the drop-down 
list, perform the following steps to add it.

a. Click Install Modem. 

The Install New Modem dialog box opens.

b. Select the Don't detect my modem check box.

c. Select Dial-Up Networking Serial Cable.

d. Select the port on which the Palm handheld is connected. 

e. Click Next.

f. Click Finish to leave the Install New Modem dialog window and return to 
the Add RAS Device window and select the option from the drop-down 
list.

8. Click OK. 

The Remote Access Setup window opens.

9. Under Port, select COM1 and then click Configure. 

The Configure Port Usage window opens.

10. Select the Receive calls only radio button and then click OK. 

11. Click Network in the Remote Access Setup window. 

The Network Configuration window opens.

12. Select TCP/IP and click the OK button. 

The RAS Server TCP/IP Configuration window opens.

13. Select Entire Network and Use Static Address Pool.
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14. Specify the requested range of TCP/IP addresses for multiple devices. Enter the 
beginning of the TCP/IP address range in the Begin field and enter the ending 
of the TCP/IP address range in the End field. 

If you have fifty devices, for example, you could define the following range:

Begin: 10.1.0.1

End: 10.1.0.51

15. Click OK.

16. In the Network Configuration window, select Any Authentication Including 
Clear Text and then click OK. 

The Remote Access Setup window opens.

17. Click Continue. 

The Setup Message window opens. 

18. Click OK. 

The Network window opens.

19. Click Close. 

The Network Settings Change window opens. 

20. Click Yes to restart the system.

When the system is restarted and you have logged in again, an error message 
might appear, saying that HotSync manager is unable to open COM1. Ignore 
this error message.

21. After the system reboots, click the Services icon in the Windows Control Panel.

The Services window opens.

22. Select Remote Access Server and click the Startup button.

23. Select Automatic and click the OK button. 

24. Click the Close button.

25. Log on as a local administrator.

Note: Use the requested range of TCP/IP addresses compliant 
with your own network. Do not use the above example.
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26. From the Windows Start menu, select Administrative Tools and then select 
User Manager. 

The User Manager window opens. Proceed to "Creating a RAS User Account 
for the Palm Handheld" on page B-16

B.3.2 Creating a RAS User Account for the Palm Handheld
Once you have configured Windows NT RAS, you need to establish a RAS user 
account. 

Steps
1. Log on locally to your own system, not to the network, as administrator. 

2. Select New User from the User menu. 

The New User dialog box opens.

3. Enter a user name, password, and password confirmation in the required fields. 

4. Select the Password Never Expires check box.

5. Click Dial-In. 

The Dial-In Information dialog box opens.

6. Select Grant Dial-In Permission to User and then click OK.

7. Click OK to exit the New User dialog box. 

8. Exit the User Manager screen.

9. From the Windows Start menu, select Administrative Tools and then select 
Remote Access Administration. 

The Remote Access Admin window opens.

10. Verify that the new RAS user is granted remote access permission and then click 
OK.
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C
Installing Oracle Mobile Field

Service/Pocket PC

This appendix describes how to install Oracle Mobile Field Service onto a Pocket 
PC.

C.1 Installing the Application on Your Pocket PC
For the minimum software and hardware requirements for the a Pocket PC, see 
"Minimum Software Requirements"  on page 2-1 and "Minimum Hardware 
Requirements"  on page 2-3.

To install Oracle Mobile Field Service on your Pocket PC, complete the procedures 
in the order listed in the following table:

Procedure Performed At

1. Downloading and Installing the Oracle9i Lite Setup 
Program 

Client PC (the PC that the 
Pocket PC HotSyncs to)

2. Performing a ActiveSync to put Oracle9i Lite 
Components, Oracle Mobile Field Service, and the 
Database on the Pocket PC

Pocket PC

3. Configuring mSync on the Pocket PC Pocket PC

4. Performing a Full Synchronization to Retrieve Oracle 
Mobile Field Service and Data

Pocket PC

5. Launching Oracle Mobile Field Service Pocket PC
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C.1.1 Downloading and Installing the Oracle9i Lite Setup Program
Perform this procedure from the client PC desktop. In this procedure, you will 
download the mobile client from the Mobile Server and install the Oracle9i Lite 
setup program. 

Steps
1. Open your browser.

2. Enter the following URL in your browser, where <Mobile Server> is the domain 
name or IP address of the Mobile Server: 

http://<Mobile Server>/setup

For example: http://130.35.88.214:8000/setup

3. Click the link to download the mobile client for Windows CE 3.00 on Pocket PC 
StrongARM setup program and save it. 

If you are using Internet Explorer, right click with the mouse, choose the option 
Save target as, and then click OK. Choose a location to save the setup program 
and click Save.

4. Using Windows Explorer, double click the setup.exe file that you just 
downloaded in order to run the setup program.

Once started, the setup program prompts you to specify an install directory.

5. Choose an install directory, for example, C:\ora_HOME, and then click OK. 

The Setup program downloads all the required components.

C.1.2 Performing a ActiveSync to put Oracle9i Lite Components, Oracle Mobile Field 
Service, and the Database on the Pocket PC

Steps
1. Connect the device to the Client PC. 

2. If you have not installed the Microsoft ActiveSync, install it and rerun the setup 
program.

3. Start Microsoft ActiveSync and then install Oracle9i Lite. 

Choose Tools > Add remove > [processor type], where 
[processor] is either SH3, SH4 or ARM.
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4. Perform an ActiveSync to put Oracle9i Lite components on the Pocket PC.
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You can also retrieve the application and copy the data onto the Pocket PC by 
connecting to any of the following modes:

� Wireless

� Infrared

� USB

� ActiveSync

� Modem

C.1.3 Configuring mSync on the Pocket PC
Follow this procedure to install the Oracle Mobile Field Service application and the 
database on the Pocket PC. 

Steps
1. On the Pocket PC, choose Start > Programs.

The Programs screen opens.

2. Tap the File Explorer icon.

The My Documents screen opens.

3. From the drop-down menu, choose MyDevice.

The My Device screen opens.

4. Tap the Orace folder.

The Orace screen opens containing the mSync file

5. Tap on the mSync file to open it.

The mSync screen opens.

Note: To do an ActiveSync to retrieve Oracle Mobile Field 
Service/Pocket PC itself and the data associated with it, the 
computer that hosts the ActiveSync manager must be able to 
connect to the mobile server using HTTP. Therefore, You must be 
able to connect to the mobile server through HTTP. 
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6. For each field, enter the value as indicated in the following table and then tap 
Apply:

C.1.4 Performing a Full Synchronization to Retrieve Oracle Mobile Field Service and 
Data

Steps
Complete the following steps to perform a full synchronization:

Field Value

User Name mSync client user name. This is case insensitive. (This is 
the Mobile Field Service username.)

Password mSync client password. This is case insensitive.

Change Leave this check box deselected.

Save Password Select this check box to save the mSync username and 
password.

Server IPaddress:port

Use Proxy Select this check box if appropriate.

Force Refresh Leave this check box deselected.

omfs_ig.book  Page 5  Thursday, December 4, 2003  11:31 AM



Installing the Application on Your Pocket PC

C-6 Oracle Mobile Field Service Implementation Guide

1. Make sure that you are connected to the network. 

2. Tap Sync to start the synchronization.

After the ActiveSync, the mobile database and the mobile application are 
replicated to the client. 

C.1.5 Launching Oracle Mobile Field Service 
Complete the following procedure to launch the Oracle Mobile Field Service 
application on the Pocket PC. 

Steps
1. On the pocket PC device, choose Start > Programs.

The Programs screen opens. 

2. Tap the File Explorer icon.

The My Documents screen opens.

3. From the drop-down menu, choose MyDevice.

The My Device screen opens.

4. Tap the Orace folder.

The Orace screen opens containing the Fieldservice.exe file

5. Click on Fieldservice.exe.

The Oracle Mobile Field Service/Pocket PC opens.

C.1.6 Creating a Shortcut for Oracle Mobile Field Service/Pocket PC
Complete the following steps to create a desktop shortcut for Oracle Mobile Field 
Service/Pocket PC:

1. Select the FieldService.exe file in the \My Device\Orace directory to get 
the selection options.

This is the same as the cut-and-paste option on the Pocket PC.

2. Choose Copy option.

3. Go to the directory where the link is to be created.

For example, \My Device\Windows\Start Menu. 
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4. Click on the Edit option in the bottom menu bar.

5. In the Menu pop-up, select Create Shortcut. 

The application can now be accessed through the shortcut and will be listed in 
the Start Menu List of programs.

C.2 Subsequent Synchronizations
This section describes how to synchronize the database on the Pocket PC. 

Steps
1. Go to the Oracle Mobile Field Service application.

2. Go to the home page of the application.

3. Click on the mSync icon. 

omfs_ig.book  Page 7  Thursday, December 4, 2003  11:31 AM



Subsequent Synchronizations

C-8 Oracle Mobile Field Service Implementation Guide

omfs_ig.book  Page 8  Thursday, December 4, 2003  11:31 AM



Setting Up Debrief Reporting D-1

D
Setting Up Debrief Reporting

This appendix describes how to set up the debrief reporting in the Oracle Mobile 
Field Service applications. 

You can set material and expense items to any billing type using billing categories. 
These billing types are mapped to either the material, labor or expense billing 
categories. Transaction types are then mapped to billing types and transaction types 
are then linked to business processes. Refer to the Oracle Field Service Implementation 
Guide for more details.

D.1 Set Up Billing Types and Service Activity Codes
In previous releases of Field Service Debrief, billing types were limited to 'L' (labor), 
'M' (material) and 'E' (expense), which prevented customers from creating different 
coverage based on the specific details of an item. For example, a customer might 
want to have different coverage on an item that is consumable rather than a 
non-consumable item. These categories also determine which tab on the Debrief 
window the item should appear: Expense, Labor, or Material. 

In this release, a new 'billing category' has been added in Service core that allows 
users to differentiate the billing types into categories of (Material) 'M', (Labor) 'L' 
and (Expense) 'E'. These billing categories, which are seeded, will be required along 
with billing type before the billing type is attached to a service activity code. As 
such, billing types are user extensible and can represent the various business needs 
that might arise in your enterprise. 

D.1.1 Defining Billing Types
You can define billing types to fit your business needs, which you can associate to 
billing categories and service activity codes. The three seeded billing types are 
Labor, Expense, and Material. Each of these billing types is associated with the 
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related billing category of the same name. When you create new billing types, they 
can be associated with either the Expense or the Material billing category. You 
cannot associate extensible user-defined billing types with the Labor category. 
Billing types are associated with Service Activity Codes and they are also associated 
with items, which you set up in Oracle Inventory.

Prerequisites
None.

Responsibility
Field Service Manager

Navigation
Field Service Dispatcher > Service Request > Others > Service: 
Lookups

Steps
1. From the Oracle Service Lookups window, choose Find from the View menu 

and then query the following lookup: MTL_Service_Billable_Flag.

The Meaning, Application, and Description are defaulted in. The Access Level 
is set at Extensible.

2. To create a new lookup, insert a record (Ctrl + down arrow) and enter a code for 
the new billing type in the Code field.

3. Enter the name of the billing type in the Meaning Field.

4. Optionally, enter a Description.

5. Leave the Tag field blank. It is not used in this lookup for Field Service.

6. Enter an Effective From date. This is the date that the billing type becomes 
active.

7. Optionally, enter an Effective To date.

If you want to deactivate a Billing Type, enter an end date that corresponds 
with the day you want the billing type to become inactive.

8. Check the Enabled check box.

9. Repeat steps 2 through 8 for each new billing type you want to create.

10. Save your work.
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D.1.2 Setting Up Billing Type Attributes
When you create billing types, you must associate them with billing categories to 
ensure that the lookups appear in on the appropriate tab in the Debrief window. 
The new extensible billing types will either be categorized as Material, if you want 
them to appear in the Materials Tab, or Expense, if you want them to appear in the 
Expense tab.

Those billing types of category Material also are used by Spares Management and 
can be tracked in Install Base.

When you set up your billing types and associated them with the appropriate 
category remember that these billing types will be associated with Service Activity 
Codes, which will appear as options in the Material or Expense tab of Debrief.

Prerequisites
Billing types must be set up.

Responsibility
Field Service Manager

Navigation
Field Service Dispatcher > Service Request > Setup > Charges > 
Billing Type Attributes

Steps
1. In the Billing Type window, create a new record and in the Billing Type field, 

choose a billing type from the list of values.

2. In the Category field, choose a category to associate your billing type with from 
the list of values.

The options are: Material or Expense.

3. Enter a start date.

Note: You cannot create extensible billing types for the Labor tab 
in debrief. You must only use the seeded billing type 'Labor' for 
Service Activity Codes associated with this billing type.
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4. Optionally, enter an end date. To keep the lookup active indefinitely, leave this 
field blank.

5. If you want to associate this Billing Type with a specific item in Inventory, select 
the item in the Rollup Item field.

6. Repeat steps 1 through 5 for each billing type you want to associate with a 
category.

7. Save your work.

D.1.3 Setting Up Service Activity Codes
You must create the service activity codes that you want to appear in the lookups on 
the Material, Labor and Expense tabs of Field Service Debrief. All activities that a 
field service representative logs in Debrief must have a related service activity code. 
These are extensible. The service activity codes are filtered by the billing type and 
associated category that you link to them. For example, a service activity code with 
a billing type of "Material" will only appear in the lookup on the Material Tab of the 
Debrief window.

Service activity codes must be categorized to represent either "issued items," or 
those items that are going to a customer, or as "returned items," or those items that 
are being retrieved from the customer. 

Prerequisites
Billing types and billing attributes must be set up.

Responsibility
Field service manager

Navigation
Field Service Dispatcher > Service Request > Setup > Charges > 
Service Activities and Billing Types

Steps
1. In the Service Activities block of the Service Activities and Billing Types 

window, create a new record (CTRL + down arrow).

2. In the Service Activity field, enter the name of the service activity code you 
want to create.

3. Optionally, enter a description of the service activity code.
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4. In the Line Category field, choose whether the service activity code is to be of 
type "Order" or type "Return."

5. Enter a start date.

6. Optionally, you can enter an end date. 

If you do not specify an end date, the service activity code will be open-ended.

7. In the Billing Types block, choose the Billing Type that you want to associated 
with service activity code that you just created from the list of values.

The description defaults from the billing type and the Start Date defaults to the 
current date.

8. Repeat step 7 for each billing type you want to associate with the service 
activity code.

9. In the Order Management Header and Line Type block, choose the operating 
unit you want to associated with the service activity code.

10. In the Order Type field, choose Mixed from the list of values.

11. In the Line Type field, choose Standard from the list of values.

12. Save your work.

D.1.4 Setting Up Material Service Activity Codes in Install Base
All service activity codes that are categorized with a billing type and category of 
"Material" must be set up in Install Base. The reason for this is these service activity 
codes are related to items that are trackable in Install Base. Service activity codes 
with both line types of "Order" and "Return" must be added to the Install Base.

Prerequisites
Service activity codes of type "Material" must be set up.

Responsibility
Field service manager

Note: The Order Type and Line Type settings are not restricted to 
the values noted above. You can use any type as long as it is set up 
correctly in Order Management. For more information, see the 
Oracle Order Management User Guide.
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Navigation
Field Service Dispatcher > Service Request > Setup > Charges > 
Install Base Transaction Types

Steps
1. When the Transaction Sub Types window opens, select the Service Type flag.

This flag will enable you to access only Service Transaction Types among the list 
of values in the Name field.

2. Query on the name of the service activity codes that you created in the Service 
Request fields and select one that you created with a billing category of 
"Material."

3. In the Source Info area, select the Reference Required check box if you want to 
include trackable items.

4. Select the Change Owner check box.

5. If the Service Activity Code has a line type of "Order," then choose External in 
the Change Owner drop-down list. If the Service Activity Code has a line time 
of Return, then choose Internal in the Change Owner field.

6. Choose a status for the source.

Do not select a status that will reflect the source as inactive, such as 
"Terminated" or "Expired."

7. In the Source Transaction Types area, set up lines for the Field Service and 
Order Management application. Select each from the list of values in the 
Application Name field.

The Field Service line will default the values in the Transaction Name, 
Transaction Type, and Description fields.

8. For the Order Management line, select Order Management Ship/Fulfill in the 
Transaction Name drop-down list.

The Transaction Type and Description fields are defaulted.

9. For both lines, select the Update IB check box to include trackable items in your 
setup.

10. Save your work.
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D.1.5 Mapping Service Activity Codes to a Business Process
Within the Oracle E-Business Suite, there may be several applications that use 
service activity request functionality. You can map the same service activity code to 
multiple business processes through this process.

You must create new business processes and then map them to the appropriate 
service activity code. See the Oracle Field Service Implementation Guide for a complete 
description of this procedure.

Prerequisites
A business process and service activity codes must be set up.

Responsibility
Field service manager

Navigation
Field Service Dispatcher > Service Request > Setup > Charges > 
Service Business Process

Steps
1. From the Service Business Process form, switch to query mode and search for 

the business process you want to associated the service activity code with in the 
Name Field.

For example, Field Service.

2. Select the Field Service check box.

The Service Request check box is selected by default. If you want to enable 
Depot Repair you can select the check box as well.

3. Optionally, enter an effective date range. 

If you leave these fields blank, the mapping will remain open ended.

4. In the Service Activities block, select the Service Activity Code you want to map 
to the Field Service business process from the list of values in the Service 
Activity field.

5. Repeat step 4 for each service activity code you want to map to the business 
process.

6. Save your work.
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E
Setting Up for Install Base Transactions

This appendix describes the install base setup procedures for the Oracle Mobile 
Field Service applications.

E.1 Setting Up System Items for Install Base Transactions

Steps
Complete the following steps to set up system items for install base transactions:

1. Log in to the Forms application using the responsibility Inventory. 

2. Create a miscellaneous transaction, putting the item in a Subinventory.

3. Navigate to Setup > Organizations > Subinventories.

4. Create at least one Subinventory in the Service Master Organization.

The Subinventory should be a Quantity Tracked, Asset Subinventory. Set the 
Locator Control value to None. Also create a Subinventory in the Palm 
Inventory Organization (which will be used as the good Subinventory).

5. In the same organization as the Subinventory of the Mobile Resource, create 
system items that are one of the following:

� Transactable (Inventory tab page)

� Trackable (Inventory tab page)

� Serviceable (Service tab page)

� Of type Material (Service tab page)

6. Put the Trackable Item you defined above in your good Subinventory (using 
Miscellaneous Transactions). Also put a Non-Trackable Item there. The 
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Trackable Item should be created as an Install Base product instance in the back 
end.

7. Under the responsibility Field Service Manager, navigate to Spares 
Management > Setup > Resource Addresses and Subinventories. 

8. Create a new record for your Mobile Resource by entering its name. Assign a 
Primary Address and the two Subinventories you created to it. 

9. The condition of the Subinventory in the Master Organization should be set to 
Defective and the condition of the Palm Organization Subinventory should 
be set to Usable.

E.2 Setting up Install Base Profile Options
Set up profiles as indicated in the following table: 

Adjusting transaction types so they can be used for install base updates can be done 
under the responsibility Installed Base Admin and navigating to Setups > 
Transaction Types and Sub Types. Transaction types can be used for 
removing install base products by setting the Change Owner To field in the Source 
Info section of the form to Internal. By setting this field to External, the 
transaction type can be used for installing new install base products.

Profile Name Value Comments

CSE: Miscellaneous Issue to 
Project Transaction Type

Issue to none

CSE: Miscellaneous Receipt From 
Project Transaction Type

Receipt from none

CSE: PA Expenditure Type Material none

CSE: Bypass Event Queue Y This profile is used to bypass some 
queues, so when miscellaneous 
transactions are created they will be 
directly inserted into Install Base.
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E.3 Removing and Installing Parts in Oracle Mobile Field 
Service/Laptop

Whether an install base update is done when removing a part in an Oracle Mobile 
Field Service application depends on the selected transaction type when doing a 
material transaction.

If the Change Owner To value of the selected transaction type is set to Internal, 
then the install base product to be removed can be indicated in Oracle Mobile Field 
Service/Laptop. 

If the Change Owner To value is set to External, than a trackable product can be 
indicated from a usable subinventory. An install base product will be created upon 
debriefing the material transaction in Field Service Report with the Update Installed 
Base check box selected.
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F
Setting Up State Transitions

F.1 Setting Up Task Status Transitions

Steps
Complete the following steps to set up task status transitions:

1. Switch to the Field Service Manager responsibility.

2. Navigate to Field Service Setup > CRM Foundation > Task and 
Escalation Manager > Setup > Define Task Status. 

The Task Statuses form displays. 

3. Click the Define Transition button to display the Status Transitions form. 

4. On the Rule tab, select Task State Transition for the Source field, Field Service 
for the Application field, and Field Service for the Rule Name field.

5. Verify that the Field Service status rule is correct. 

The seeded Field Service status rule is defined in the following table:

Current State Next State 

In Planning Assigned

In Planning Cancelled

Assigned Accepted

Assigned Rejected

Assigned Cancelled

Assigned Completed
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Assigned Working

Accepted Rejected

Accepted Cancelled

Accepted Working

Rejected Assigned

Rejected Accepted

Rejected Cancelled

Rejected Working

Cancelled In Planning

Cancelled Assigned

Cancelled Closed

Completed Closed

Working Cancelled

Working Completed

Working Interrupted

Interrupted In planning

Interrupted Assigned

Interrupted Cancelled

Interrupted Completed

Interrupted Working

Unassigned In Planning

Unassigned Assigned

Unassigned Cancelled

Current State Next State (Cont.)
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F.2 Assigning the State Transition Rule to a Responsibility

Steps
Complete the following steps to assign the state transition rule to a responsibility:

1. Click the Responsibility tab. 

2. Select a responsibility in the Responsibility field.

3. Assign the rule to the responsibility by selecting the rule name in the Rule field.

4. Save your work.

5. Close the form.
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G
Setting Up Spares Management in Oracle

Mobile Field Service

This appendix describes the ordering and transferring of spare parts and setting up 
resource addresses and subinventories in Oracle Mobile Field Service. 

G.1 Ordering and Transferring Parts
To create an item order in an Oracle Mobile Field Service application, at least one 
usable (good) subinventory has to be defined and assigned to the field service 
representative. Two usable subinventories have to be defined and assigned to the 
field service representative in order to do transfers.

Subinventories are set up using the Field Service Administrator responsibility and 
the Resource Addresses and Subinventories form, which you can access from the 
following path:

Field Service Dispatcher > Spares Management > Setup > 
Resource Addresses and Subinventories
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G.2 Setting Up Resource Addresses and Subinventories
When ordering an item, resource addresses can be used by the field service 
representative to indicate where the item should be sent.

Prerequisites
� Use the Field Service Administrator responsibility and open the Resource 

Addresses and Subinventories form. See "Ordering and Transferring Parts" on 
page G-1 for complete details.

Steps
From the Resource Addresses and Subinventories form, complete the following 
steps to set up resource addresses and subinventories:

1. Type a resource type and name in the Resource Type and Resource Name fields. 

2. Enter resource addresses.

a. From the Addresses tab, enter the address style in the Style field and then 
click the Address field.

b. In the Location Addresses form, enter the location address details and click 
OK. 

The form closes.

c. Enter the time zone in the Time zone field. 

d. If the entered address should be the primary address, then select the 
Primary check box.

e. To deactivate an address, select the appropriate Inactive check box.

3. Assign subinventories.

a. Enter the organization in the Organization field.

b. Enter the subinventory in the Subinventory field

c. From the Condition drop-down list, select Usable.

d. If the entered Subinventory should be the default Subinventory for the 
Mobile Resource, then select the Default check box. 

e. Optionally, set the period for which the subinventory is valid in the Start 
Date and End Date fields.
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H
Setting Up Descriptive Flexfields

This appendix describes how to set up descriptive flexfields in an Oracle Mobile 
Field Service application. Refer to the Oracle Applications Flexfields Guide to learn 
more about descriptive flexfields.

Steps
Complete the following steps to set up the descriptive flexfields in Oracle 
Applications that are specific to an Oracle Mobile Field Service application:

1. Log in to Oracle Applications as a system administrator and choose the System 
Administrator responsibility. 

2. Navigate to Application > Flexfield > Descriptive > Segments.

3. Click the Application field and search for Oracle Service. 

4. Click the Title field and search for the component for which the flexfield(s) 
should be created. 

The following table lists the possible values that can be selected here for 
flexfield creation or updates: 

Value for Application Field Value for Title Field 

Oracle Service Customers

Oracle Service Service Request

Oracle Service Tasks

Install Base Item Instance Flexfield Details

Oracle Inventory Items
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5. The Freeze Flexfield Definition check box indicates whether or not Flexfields 
can be defined or updated. Make sure it is deselected so new Flexfields can be 
defined.

6. Click Segments to display the Segments Summary form. 

7. Click New to create a new flexfield definition or click Open to open an existing 
flexfield definition. 

8. Enter the Segment name in the Name field.

9. Click the button next to the Column field and select an attribute column from 
the Column list of values. 

10. Enter a description in the Description field and a number in the Number field.

11.  Click the search button in the Value Sets field and select a value set (this is the 
data type of the Flexfield) from the list of values. The Description field will be 
automatically filled. 

12. You can also select a default type from the Default Type list of values to indicate 
a default value in the Default Value field. Select or deselect the Required check 
box to specify whether a value is required or not.

13. Specify the flexfield size information in the Sizes section of the form.

14. Optionally, specify prompt information in the Prompts section of the form. 

For example, prompts could be used when displaying a window that requests 
data input for the Flexfield.

15. Optionally, click ValueSet to open the form where you can define new value 
sets or update existing value sets.

16. Click Save to save the new flexfield definition and close the Segments form

17. Review the Segments Summary form shown and then close it. 

18. If no more updates are needed, select the Freeze Flexfield Definition check box.

19. Click Compile.
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I
Signature Capture

A field service representative can capture the signature of a customer after 
performing the debrief on the Palm handheld or Pocket PC. The signature is then 
synchronized with the enterprise system.

You can view a captured signature in the appropriate debrief screen of the Forms 
application. Viewing a signature in the Debrief form is exactly the same as viewing 
any other attachment.

On the toolbar, there is paper clip icon. When you select an attachment linked to the 
Debrief, the icon changes to a paper clip attached to a yellow document.

If the attachment viewer in the Forms application is not working, then check that 
the entries in wdbsver.app (found in the Forms tier setup) are similar to the 
following:

� connect_string = mobxbld1

� password = apps

� username = apps

� default_page = APPS.fnd_web.ping

� document_table = APPS.fnd_lobs_document

� document_path = docs

� document_proc = (null)

� name_prefix = (null)

� always_describe = (null)

� after_proc = (null) 

� before_proc = (null)
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� reuse = YES

� connmax = 30

� upload_as_long_raw = (null)

� upload_as_blob = *

� pathalias = fndgfm

� pathaliasproc = fnd_gfm.dispatch

omfs_ig.book  Page 2  Thursday, December 4, 2003  11:31 AM



Process Flow J-1

J
Process Flow

This appendix describes the typical field office work flow (Oracle Field Service) and 
the typical field service representative work flow (Oracle Mobile Field Service).

J.1 The Oracle Field Service Process
The field service process has six basic steps. This process starts with the creation of a 
service request. The service request has at least one task, which is completed by a 
field service representative in the field. After completing a task, the field service 
representative electronically submits the task details to the home office, which is 
now able to create an invoice. The field service process is driven by the service 
request status and task status changes, electronically exchanged between the field 
service representative and home office. The basic steps of the field service process 
are described in the following table:

Steps Description 

1. Service request 
intake and 
validation

There are several ways to report a request for service. The 
customer can create the request by using the Web, Computer 
Telephone Integration (CTI), e-mail, or by dialing into a call 
center where an agent takes the call. A service request can also 
be created by a field service representative through a project or 
by a sales order (installation of a product). When the request is 
received, the customer, product and contract are checked in the 
validation step.

omfs_ig.book  Page 1  Thursday, December 4, 2003  11:31 AM



The Oracle Field Service Process

J-2 Oracle Mobile Field Service Implementation Guide

2. Service request 
screening and 
qualification 

After a service request is created, it is screened to avoid a field 
visit. The service request is analyzed by a support agent who 
searches the knowledge base for a solution. As an outcome of 
this process, the request may be closed, a part may be shipped to 
the customer, or the customer might ship the part for in-house 
repair. When a field visit is required, a task is created based on 
the problem description and action needed to resolve the 
problem. A definition for the parts necessary to resolve the task 
is also given. The creation of a task for installation or 
maintenance of customer product can be created automatically 
from a service contract or sales order.

3. Service request 
planning and 
dispatch

The tasks must be scheduled, assigned, and dispatched to the 
field service representative. The scheduling of the tasks is done 
based on various constraints such as skills, location, availability, 
and required parts. When the tasks assignment is done, the task 
or schedule is dispatched to the service representative. The 
service representative receives notification and progress on the 
task is monitored.

4. Service request 
delivery and 
reporting

Once field service representatives receive an assigned task or 
schedule, they can begin service at the customer site. They 
report on progress, materials used and recovered, expenses, and 
labor time. Additionally, they can record counter readings and 
describe how the problem was resolved. It might be necessary to 
create new tasks or service requests if the field service 
representative cannot help the customer immediately. They can 
recover the product or product part for repair. All the reported 
information is used for billing the customer. Reporting on 
materials-used also results in automatic replenishment of the 
inventory in the service vehicle.

5. Service request 
monitoring 

Unforeseeable events can occur that impact the progress of a 
task. In this case, escalations can be raised to indicate this 
situation.

6. Service request 
completion and 
billing 

When field service representatives complete a task, they sets the 
task status as COMPLETE and then move on to the next task. 
The task information is checked by an agent at the home office 
for any service contract coverage and then an invoice is created. 
The inventories, sub-inventories, and install base are all 
updated.

Note: Depending on your service organization, the above steps 
can be separated or combined.

Steps Description 
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The component in step 4, Service request delivery and reporting, can be applied 
using Oracle Mobile Field Service. In this application, the schedule is received by 
the field service representative on his mobile computer device. He then records 
counter readings and reports on material used, labor time, and expenses incurred. 

J.2 Various Orders of Task Completion
Field service representatives can complete their scheduled tasks under different 
scenarios.

Scenario 1: Complete Scheduled Tasks in Pre-determined Order
In this scenario, the field service representative works on one job at a time and 
conforms to the dispatched schedule. For instance, the following tasks may be 
assigned to a field service representative:

� task 1: 8:00 Installation at Customer A

� task 2: 9:00 Repair on-site at Customer B

� task 3: 10:00 Installation at Customer C

The field service representative first needs to finish task 1 before going on to task 2. 
He needs to follow the pre-defined order of the dispatcher. The field service 
representative cannot reschedule tasks, but he can reject a task. 

This setup gives the dispatcher control over the daily schedule of the field service 
representative. The dispatcher sets up the tasks, including what time and where the 
field service representative is to be at all times.

Scenario 2: Complete One Scheduled Task at a Time in Any Order
In this scenario, the field service representative works on a single job at a time and 
need not conform to the dispatched schedule.

Scenario 3: Complete Multiple Scheduled Tasks in Any Order
In this scenario, the field service representative works on multiple jobs at a time and 
does not conform to the dispatched schedule.

Scenario 2 and Scenario 3 gives field service representatives control over their day. 
The dispatcher sends the tasks and locations to the field service representative, and 
the service representative then decides when to perform each task. This scenario 
works well in an environment where each task requires only one field service 
representative. For example, if a field service representative has a dental 
appointment, he can arrange the time he wants to be at the customer site near his 

omfs_ig.book  Page 3  Thursday, December 4, 2003  11:31 AM



Avoiding Multiple Task Assignments

J-4 Oracle Mobile Field Service Implementation Guide

dentist. The field service representative is expected to complete all the tasks on the 
day they were assigned. If he is unable to complete a scheduled task, he can reject it 
and then the dispatcher will re-schedule the task for the next day.

J.3 Avoiding Multiple Task Assignments
If you send more than one field service representative to perform a task, ensure that 
you schedule only one task assignment at a time, because multiple task assignments 
can lead to conflicts. For example, suppose you have a task that requires three field 
service representatives. You set up the task and then you send it to all three 
representatives. It now appears on their schedules. However, if one of your field 
service representatives changes the time for his task, that would affect the schedules 
of the other two representatives. To avoid this, you must create three tasks, one for 
each representative.
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K
Category Set for Item Replication

The following system items are replicated to mobile computer devices:

� Items used in a service request assigned to/created by the mobile user

� Item instance items used in a service request assigned to/created by the mobile 
user

� Items used in debrief lines

� Items used in item orders

� Items present in a good subinventory assigned to the mobile user

� Items present in the inventory organization specified by profile CSL_APPL_
ORGANIZATION_ID. 

For Oracle Mobile Field Service/Laptop, set the following profiles to filter the 
system by category:

� CSL: Item Category Filter 

� CSL: Item Category Set Filter 

See "Setting up Profile Options for Oracle Mobile Field Service/Laptop" on page 3-7 
for a complete description of these profiles.

For Oracle Mobile Field Service/Palm or Oracle Mobile Field Service/Pocket PC, 
set the following profiles to filter the system by category:

� CSM: Item Category Filter 

� CSM: Item Category Set Filter 

See "Setting up Profile Options for Oracle Mobile Field Service/Palm" on page 3-13 
or "Setting up Profile Options for Oracle Mobile Field Service/Pocket PC" on 
page 3-15 for a complete description of these profiles.
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The two category profiles for the Oracle Mobile Field Service applications enable 
you to setup category sets (profile 1) and relate categories to this (profile 2). The 
category set and category profile make the unique key for replication. The values 
that can be selected for the category set profile are all categories sets of the master 
organization and the inventory organizations. 

The following are the rules governing the use of category profiles. 

� If the category profile is not set (no category is entered), then all items related to 
the default inventory organization are replicated to the mobile clients

� If the category profile is set (category is entered), then the system items 
replicated are filtered based in inventory organization and category. 

� Items used in a service request created on the backend will not be impacted by 
this profile. But for service requests that the field service representative wants to 
create on a mobile computer device the category profile will limit the list of 
items available. 

� The category profile does not affect the OnHandQty (stock in subinventory).

If profiles CSL_ITEM_CATEGORY_SET_FILTER and CSL_ITEM_CATEGORY_
FILTER are also both set, an additional filter on the item category/category set 
combination applies.

Items used in a field service report debrief are replicated as normal. This is 
independent of the category profile.

Note: You can set the category profiles for the Oracle Mobile Field 
Service applications at all levels.
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L
National Language Support

This appendix describes how to use National Language Support (NLS) to change 
the default language of Oracle Mobile Field Service, English, to the desired 
language of the user.

The profile option ICX: Language determines the language in which field service 
representatives receive data, messages, and labels for Oracle Mobile Field Service/ 
or Oracle Mobile Field Service/Palm.

As a prerequisite, install the NLS language for the Oracle E-Business Suite and then 
apply all patches in the NLS language when applicable. 

From the Forms application, complete the following steps to change the default 
language of Oracle Mobile Field Service:

1. Change the profile ICX: Language to the desired language.

a. Login with System Administrator responsibility.

b. Navigate to Profile / System.

c. Check the User check box and then enter the username.

d. Enter the Profile option name, ICX: Language, and then click Find.

e. Change the language of the user level.

2. Run the Manage Mobile Users concurrent program (if it is not scheduled).

a. Login with Mobile Administrator responsibility.

b. Navigate to Concurrent / Requests.

c. Click OK to submit a single concurrent request.

d. Choose the Manage Mobile Users concurrent program from the list of 
values.
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e. Click OK.

The Manage Mobile Users concurrent program detects the language change and 
then removes all records in the old language and insert them in the new language. 
This in turn, causes a full synchronization. After this synchronization, the user sees 
the application and data in the new language. 

Oracle9i Lite can only use one language code set at a time. Oracle9i Lite has five sets 
of client libraries, one for each language (encoding). English/Western European, 
Japanese, Korean, Traditional Chinese, and Chinese are supported. When the 
Oracle9i Lite Mobile Server is installed, it will only install one set of client libraries. 
Therefore, an additional mobile server installation is required for every language if 
it uses a different code set. The administrator has to setup different URLs for each 
language. For example, the URL for English is the following: 
server/webtogo/setup_eng.htm, server/webtogo/setup_jp.htm. Users 
have to be informed of which URL they should use, based on the language they 
want.

As long as the languages use the same code set (such as English and Spanish), only 
one mobile server is required, as explained earlier.
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